
If you are not familiar with Windows, review this “Windows Tutorial” carefully.
You will learn how to

• Use a mouse.

• Start Windows.

• Use the taskbar, menus, Ribbon, dialog boxes, and other important 
aspects of Windows.

If you are familiar with Windows but need help navigating 
Windows files and folders, refer to the section “File 
Management.” There you will find information on how 
Windows stores information and how to use Windows 
Explorer, a tool for managing files and folders.

Computers differ in the ways they can be set up. In most 
cases, when you turn on your computer, Windows loads 
automatically and the Windows log-on screen appears. 
When you see the Windows log-on screen, you need to log 
on and key a password. In order to log on, you need to know 
how to use the mouse, a device attached to your computer.

Using the Mouse
A mouse is a pointing device that is typically attached to your computer. 
Optical versions, which are not attached, are also available. The mouse is 
your access to the computer screen, allowing you to accomplish specific 
tasks. It operates through a pointer, a screen object you use to point to 
objects on the computer screen. The normal shape for the mouse cursor is 
an arrow. To move the pointer arrow on the screen, you roll the mouse on 
any flat object, or on a mouse pad, which has a smooth surface designed for 
easy mouse rolling. Although you can use the keyboard with Windows, you 
will probably find yourself using the mouse most of the time.
 To use the mouse to point to an object on the computer screen:

 1. Turn on the computer (if it is not on already). Windows loads, and the 
log-on screen appears. The screen includes a log-on name and picture 
assigned to you by your instructor.

To log on, you need to move the mouse pointer to the log-on name that was 
assigned. The pointer on the computer screen mirrors the actions made by 
the mouse when you roll it. Place your hand over the mouse and roll it to the 
left. The pointer on the screen moves to the left.

  2. Roll the mouse to the right, and watch the pointer on the screen move to 
the right.

 3. Practice rolling the mouse in all directions.

 4. Roll your mouse to the edge of the pad, and then lift it up and place 
it back in the middle of the pad. Try it now to see how it works. When 
you feel that you can control the mouse position on the screen, roll the 
mouse to the name you have been assigned.

windows tutorial

NOTE

All examples in this tutorial refer 
specifically to Windows Vista. If you are 

using any other version of Windows, 
your screen might differ slightly from the 
images shown in this tutorial. However, 

because most basic features are common 
to all versions of Windows, this tutorial 

should be helpful to you no matter which 
version of Windows you use.
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To log on, you will need to click the name to select it. Mouse clicks are 
covered in the next section; instructions for logging onto Windows Vista are 
covered in succeeding sections.

Clicks and Double-Clicks
A mouse typically has two buttons at the front (the edge of the mouse 
where the cord attaches)—one on the left (primary) and one on the right 
(secondary). A mouse might also have a center button or a wheel.
 Single-click actions with the mouse are used to position the pointer at a 
specific screen location. To perform a single click:

 1. Roll the mouse around on the mouse pad until the pointer on the screen 
is over an object on the screen. Remember that the direction in which 
you move the mouse on the pad represents the pointer’s movement on 
the screen.

 2. Press and release the left mouse button once. Pressing and releasing 
the mouse button is referred to as a click. The computer tells you that 
the action has been performed when the object you click is highlighted 
(typically, the color of the selected object changes) to indicate to you 
that it has been selected. In Windows, you often need to select an object 
before you can perform an action. For example, you usually need to 
select an object before you can copy it.

 Pressing and releasing the mouse button twice is referred to as a double-
click. When you double-click an object on the screen, it is selected—the 
object is highlighted—and an action is performed. For example:

•   When you double-click a folder, it is highlighted 
and opens to a window showing the items the folder 
contains.

•   When you double-click a word in a text file, it is 
selected for a future action. In a text file, the pointer 
becomes an I-beam for selecting text in the document.

Selecting and Highlighting
You can also select a larger object such as a picture or a block of text by 
using the mouse.

 1. Position the pointer on one side of the object, and hold down the left 
mouse button.

 2. Roll the mouse until the pointer reaches the other side of the object.

 3. Release the mouse button. The selected object is highlighted.

Drag and Drop—Moving an Object 
Using the Mouse
You can use the mouse to move an object on the screen to another screen 
location. In this operation, you select an object and drag the mouse to move 
the selected object, such as an icon. The operation is known as drag and 
drop.

NOTE

Whenever you are told to “click” or 
“double-click” an object on the computer 

screen, use the left mouse button.
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 1. Using the mouse, move the pointer over the object you want to drag.

 2. Perform a single-click action by pressing the left mouse button but keep 
it pressed down. The selected object will be highlighted.

 3. With the left mouse button still depressed, roll the mouse until the 
pointer and selected object are placed at the desired new location.

 4. Release the mouse button to drop the object. The object is now 
positioned at the new location.

Using the Right Mouse Button
Pressing and quickly releasing the right mouse button is referred to as a right-
click. Although the right mouse button is used less frequently, using it can 
be a real time-saver. When you right-click an icon, a shortcut menu appears 
with a list of commands. The list of commands displayed varies for each icon 
or object.
 As you progress in this tutorial, you will become familiar with the terms 
in Table 1, describing the actions you can take with a mouse.

 

TABLE 1 Mouse Terms

TERM DESCRIPTION

Point  Roll the mouse until the tip of the pointer is touching the desired 
object on the computer screen.

Click  Quickly press and release the left mouse button. Single-clicking 
selects objects.

Double-click  Quickly press and release the left mouse button twice. Double-
clicking selects an object and performs an action such as opening a 
folder.

Drag  Point to an object on screen, hold down the left mouse button, and 
roll the mouse until the pointer is in position. Then release the mouse 
button (drag and drop).

Right-click  Quickly press and release the right mouse button. A shortcut menu 
appears.

Select  When working in Windows, you must first select an object in order to 
work with it. Many objects are selected with a single click. However, 
depending on the size and type of object to be selected, you may 
need to roll the mouse to include an entire area: Holding down the 
left mouse button, roll the mouse so that the pointer moves from one 
side of an object to another. Then release the mouse button.

Pointer Shapes
As you perform actions on screen using the mouse, the mouse pointer 
changes its shape, depending on where it is located and what operation you 
are performing. Table 2 shows the most common types of mouse pointers.
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Starting Windows: The Log-on Screen
The Windows Vista log-on screen allows several people to use the same 
computer at different times. Each person is assigned a user account that 
determines which files and folders you can access and your personal 
preferences, such as your desktop background. Each person’s files are hidden 
from the others using the computer. However, users may share selected files 
using the Public folder. The log-on screen lists each user allocated to the 
computer by name.
 If the administrator has added your name to a given computer, the log-on 
screen will include your name. If the computers are not assigned to specific 
individuals, you may find a box for Guest or for a generic user. If your 
computer is on a network, your instructor might need to provide you with 
special start-up instructions.

After you have logged on to Windows Vista, the desktop 
is the first screen you will see. It is your on-screen work 
area. All the elements you need to start working with 
Windows appear on the desktop.

 1.  If you have not already turned on the computer, do so 
now to begin the Windows Vista loading process. The 
Windows log-on screen appears.

TABLE 2 Frequently Used Mouse Pointers

SHAPE NAME DESCRIPTION

 Pointer Used to point to objects.

 I-Beam  Used in typing, inserting, and selecting text. 
When the I-beam is moved to a selected 
location, it turns into a blinking bar.

 Two-pointed arrow  Used to change the size of objects or 
windows.

 Four-pointed arrow Used to move objects.

 Busy Indicates the computer is processing a
   command. While the busy or working in 

background pointer is displayed, it is best
 Working in background  to wait rather than try to continue working. 

Note: Some of the working in background 
actions will not allow you to perform other 
procedures until processing is completed.

 Hand  Used to select a link in Windows’ Help or 
other programs.

NOTE

On some computers, the log-on screen 
does not appear automatically. You might 

have to press the following keys, all at 
once, and then quickly release them: 

Ctrl � Alt � Delete .
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 2. Click your name to select it. The Password box appears with an I-beam 
in position ready for you to type your password.

 3. Type your password.

 4. Click the arrow icon to the right of the box. If you have entered the 
password correctly, the Windows desktop appears. If you made an error, 
the Password box returns for you to type the correct password.

The Windows Desktop
The Desktop includes the Start button, taskbar, and sidebar. You may also 
see icons on the desktop that represent folders, programs, or other objects. 
You can add and delete icons from the desktop as well as change the desktop 
background. The Start button is your entry into Vista functions.

Figure 1
Windows Vista 

Desktop

Using the Start Menu
Click the taskbar Start button to open the Start menu. You can also press 
the Windows logo key on the keyboard to open the Start menu. Use the 
Start menu to launch programs, adjust computer settings, search for files 
and folders, and turn off the computer. If this is a computer assigned to 
you for log-on, your Start menu may contain items that differ from those of 
another user assigned to the same computer. To open and learn about the 
Start menu, first click the Start button on the Windows taskbar. The Start 
menu appears.

Icons

Sidebar 

Taskbar 

Start button

Quick Launch Toolbar Notification area
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 The left pane consists of three sections divided by separator lines. The 
top section, called the pin area, lists programs that are always available for 
you to click. These can include your Internet browser, e-mail program, your 
word processor, and so forth. You can remove programs you do not want 
listed, rearrange them, and add those you prefer.
 Below the separator line are shortcuts to programs you use most often, 
placed there automatically by Windows. You can remove programs you do 
not want listed, rearrange them, but not add any manually.
 All Programs displays a list of programs on your computer and is used to 
launch programs not listed on the Start menu.
 Below the left pane is the Search box which is used to locate programs 
and files on your computer.
 The right pane is also divided into three sections. It is used to select 
folders, files, and commands and to change settings. Use the icons at the 
bottom of the right pane to save your session, lock the computer, restart, 
switch users, and shut down.

Figure 2
Start menu

Pin area

Click to open All 
Programs

Power button

Lock button
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TABLE 3 Typical Components of the Start Menu

COMMAND USE

Left Pane
Pin area  Lists programs that are always available. You can add and 

delete items to the pin area.
Internet Connects to the default browser.
E-mail Connects to the chosen e-mail service.

Below the First Separator Line
Programs  Lists programs that you use most often. You can add to and 

rearrange the programs listed.

Below the Second Separator Line
All Programs  Click to display a list of programs in alphabetical order and a 

list of folders. Click to open a program.
Start Search  Use to search programs and folders. Key text and results 

appear.

Right Pane
Personal folder Opens the User folder.
Documents Opens the Documents folder.
Pictures Opens the Pictures folder.
Music Opens the Music folder.
Games Opens the Games folder.
Search  Opens the Search Results window. Advanced Search options 

are available.
Recent Items  Opens a list of the most recent documents you have opened 

and saved.
Computer  Opens a window where you can access disk drives and other 

hardware devices.
Network  Opens the Network window where you can access computers 

and other devices on your network.
Connect To  Opens a window where you can connect to a different 

network.
Control Panel Opens the Control Panel.
Default Programs  Opens the Default Programs window where you can define 

default programs and settings.
Help and Support  Opens the Windows Help and Support window. Help 

offers instructions on how to perform tasks in the Windows 
environment.

Power button Turns off the computer.
Lock button  Locks the computer, or click the arrow beside the Lock 

button to display a menu for switching users, logging off, 
restarting, or shutting down the computer.

Table 3 describes the typical components of the Start menu.

Using the All Programs Command
Most programs on your computer can be started from the All Programs 
command on the Start menu. This is the easiest way to open a program not 
listed directly on the Start menu.

 1. To open the All Programs menu, click the Start button. The Start menu 
appears.
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 2. Click All Programs or the triangle to the left near the bottom of the left 
pane. The All Programs menu appears, listing the programs installed on 
your computer. Every computer has a different list of programs. Notice 
that some menu entries have an icon to the left of the name and others 
display a folder. Click a folder, and a list of programs stored in that 
folder appears. Click a program to open it. Point to a program to see a 
short description of the program.

Figure 3
All Programs 

window

Program icons

Folder containing 
programs

Click to return to 
opening Start menu

 3. Click Microsoft Office to open a list of programs in the Microsoft 
Office folder. Click Microsoft Office Word 2007. (See Figure 3.) In a few 
seconds, the program you selected loads and the Word window appears. 
Notice that a button for the program appears on the taskbar. Leave 
Word open for the present.
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Customizing the Start Menu
Both the Start menu and the desktop can be customized. You can add 
shortcuts to the desktop if you prefer, and you can add and delete items 
from the Start menu. However, if your computer is used by others, the 
administrator may limit some customization functions.
 To add a program to the pin area of the Start menu:

 1. Select the program you want to add to the pin list from the All Programs 
menu, and right-click it. A shortcut menu appears.

 2. Click Pin To Start Menu on the shortcut menu. The program will be 
added to the pin list in the left pane above the first separator line.

 To remove a program from the pin area of the Start menu:

 1. Select the program you want to remove from the pin list, and right-click. 
A shortcut menu appears.

 2. Click Unpin From Start Menu. The program will be removed from the 
pin list.

 To change the order in which programs are listed in the pin area:

 1. Point to the program icon.

 2. Drag the icon to the desired position.

Using the Taskbar
The taskbar at the bottom of your screen is one of the most important features 
in Windows Vista. The taskbar is divided into several segments, each dedicated 
to a different use. It shows programs that are running, and you can use the 
taskbar to switch between open programs and between open documents within 
a program. If your computer has the Aero interface, a thumbnail preview 
appears when you move the mouse over a button on the taskbar.

Figure 4
The Desktop with 

the taskbar and the 
Word window

Active window

Word button on 
the taskbar

Microsoft Office Button
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 Windows displays a button on the taskbar for each opened program and 
document. Notice that there is a button for Word, showing the Word icon 
and the name of the program. Point to the Word button to view a thumbnail 
of the document window. Since the taskbar can become crowded, Windows 
combines access to documents or programs under single buttons. The button 
shows the name of the program (Microsoft Office Word) and the number of 
items in the group (9). The shape of the arrow varies, depending on what the 
button contains. Clicking the button opens the menu of available items.

Figure 5
Button contents for 
Word documents

List of open documents in Word

Taskbar button to open Word program

Taskbar Notification Area
The notification area is on the right side of the taskbar, where the current 
time is usually displayed. Along with displaying the time, tiny icons notify 
you as to the status of your browser connection, virus protection, and so 

forth. It is also known as the system tray. In the interest of 
removing clutter, the notification area hides most of the 
icons. Clicking the Show Hidden Icons button  “hides” 
or “unhides” the icons in the notification area. Click 
the left-pointing arrow next to the icons to expand the 
notification area. Click the right-pointing arrow to hide 
the notification area.

The Active Window
The window in which you are working is called the active window. The 
title bar for the active window is highlighted, and its taskbar button is also 
highlighted. The program window for Microsoft Word that you opened 
earlier should still be open. To examine additional features of the taskbar, 
open a second program, Microsoft Excel, a spreadsheet program in Microsoft 
Office.

 1. If Word is not open, click the Start button and then click All Programs, 
Microsoft Office, Microsoft Office Word 2007 from the Start menu. The 
Word window displays.

 2. Click the Start button and then click All Programs, Microsoft Office, 
Microsoft Office Excel 2007 from the Start menu. The Excel window 
displays. Notice how the Excel window covers the Word window, 
indicating that the window containing Excel is now active. Notice, too, 
that a new button for Excel has been added to the taskbar.

TIP

If you are not sure of what an item is 
or does, pointing to it without clicking 

displays a ScreenTip with a short 
description.
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 3. Click the button on the taskbar for Word, the first program you opened. 
Word reappears in front of Excel. Notice the change in the appearance 
of the title bar for each program.

 4. Click the button on the taskbar for Excel. Notice that you switch back to 
Excel.

 5. Click the button on the taskbar to return to Word.

 6. Locate the Quick Launch toolbar to the right of the Start button, and 
point to the Switch between windows button .

 7. Click the Switch between windows button, and notice the desktop view.

 8. Click the Excel window.

Changing the Size of the Taskbar
You can change the size of the taskbar using your mouse if your toolbar is 
crowded. It is usually not necessary, because of the multiple document style 
buttons and other hide/unhide arrows on the taskbar. Before you can change 
the size of the taskbar, it may be necessary for you to unlock it. To unlock the 
taskbar, right-click an open area of the taskbar and click Lock the Taskbar to 
remove the checkmark. A checkmark is a toggle command. Click to turn it 
off, and click a second time to turn it on.

 1. Move the pointer to the top edge of the taskbar until it changes from a 
pointer to a two-pointed arrow . Using the two-pointed arrow, you 
can change the size of the taskbar.

Figure 6
Excel (the active 

window) covering 
the Word window

Word window

Active title bar

The Excel window is now 
the active window

Quick Launch toolbar Taskbar button for 
open Excel program
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 2.  With the pointer displayed as a two-pointed arrow, hold down the left 
mouse button and move the arrow up until the taskbar enlarges upward.

 3.  Move the pointer to the top edge of the taskbar once again until the two-
pointed arrow displays. Hold down the left mouse button, and move the 
arrow down to the bottom of the screen. The taskbar is restored to its 
original size.

Using Menus
Windows uses a system of menus that contain a choice of options for working 
with programs and documents. Most Windows programs use a similar menu 
structure. These operations are either mouse or keyboard driven. They are 
called commands because they “command” the computer to perform functions 
needed to complete the task you, the user, initiate at the menu level.

Executing a Command from a Menu
In Windows, a program may display a menu bar, a row of descriptive menu 
names at the top, just below the title bar. You open a menu by clicking the 
menu name listed in the menu bar. When a menu is opened, a list of command 
options appears. To execute a particular command from an open menu, press 
the left mouse button and then drag down and release the chosen option 
(click and drag). You can also click the command once the menu is open.

Keyboard Menu Commands
For people who prefer to use the keyboard to a mouse, Windows has provided 
keyboard commands for many menu items. You can use the keyboard to 
open menus and choose menu options.
 Some menu items include not only the name of the command but a 
combination of keyboard keys. For example, under the File menu in WordPad, 
the Save command contains the notation Ctrl � S  to its right. This means that 
you can also execute the command by pressing the Ctrl  key together with the S

key to save a document.

Figure 7
Title and menu bars 
with the File menu 

Open

Other Menu Symbols
Three dots following a menu option indicate that a dialog box is displayed 
when that menu option is chosen. (Dialog boxes, discussed later, are small 
windows requesting and receiving input from a user.) Some commands 
also display a check box. Click an empty check box to select the option. A 
checkmark will appear in the square and indicates the option is selected. To 
turn off the option, click the check box to remove the checkmark. Commands 
that appear gray or dimmed are currently not available.

Command with three 
dots opens a dialog box.

Command name

Keyboard shortcut

Menu bar
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Perform the following steps for keyboard command practice:

 1.  Open the Start menu, click All Programs, and click the Accessories folder. 
Click WordPad. The WordPad program opens, and a button appears on 
the Windows taskbar.

 2. Click File in the menu bar. The File menu displays. Click File to close the 
menu.

 3. Press Alt , and notice that the items in the menu bar display underlined 
letters (File, Edit). The underlined letters are a shortcut to open a menu. 
Press the letter “f” to open the File menu. Release Alt , and click outside 
the menu in a blank area to close the menu.

 4. Press Alt � V , the keyboard shortcut for the View menu. The View menu 
displays.

 5. Notice the four check boxes. All are selected. Click the Options 
command. The Options dialog box opens.

 6. Click Cancel to close the dialog box.

 7. Click File in the menu bar. Click Exit. Click Don’t Save if prompted to save 
the document.

Displaying a Shortcut Menu
When the mouse pointer is on an object or an area of the Windows desktop 
and you right-click, a shortcut menu appears. A shortcut menu typically 
contains commands that are useful in working with the object or area of the 
desktop to which you are currently pointing.

 1.  Position the mouse pointer on a blank area of the desktop, and right-click. 
A shortcut menu appears with commands that relate to the desktop, 
including view and sort options.

 2. Click outside the shortcut menu to close it.

 3. Right-click the time in the bottom right corner of the taskbar. A shortcut 
menu appears.

 4. Click Adjust Date/Time on the shortcut menu. The Date/Time Properties 
dialog box appears. You can use this dialog box to adjust your 
computer’s date and time.

Figure 8
The Time shortcut 

menu
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 5. Click Cancel.

 6. Right-click an icon on the desktop to display its shortcut menu, and 
then close the shortcut menu.

Using the Ribbon
Microsoft Office 2007 applications include a Microsoft Office Button, a Quick 
Access Toolbar, and a Ribbon. The Microsoft Office Button displays the Office 
menu which lists the commands to create, open, save, and print a document. 
The Quick Access Toolbar contains frequently used commands and is positioned 
to the right of the Microsoft Office Button. The Ribbon consists of seven tabs 
by default, and each tab contains a group of related commands. The number 
of commands for each tab varies. A command can be one of several formats. 
The most popular formats include buttons and drop-down lists.

NOTE

A keyboard shortcut is available for the 
print dialog box: Press Ctrl � P  to open 

the Print dialog box.

Microsoft Office Button

Ribbon

Quick Access 
Toolbar Groups Tabs

 1. Activate the Excel program.

 2. Point to and click the Microsoft Office Button. Notice the commands and 
icons in the menu.

 3. Click a blank area of the window to close the menu.

 4. Locate the Quick Access Toolbar beside the Microsoft Office Button. 
Point to each button in the Quick Access Toolbar to identify it. Notice 
that a keyboard shortcut displays beside each button.

 5. Click the Page Layout tab. Notice the change in the groups and commands.

 6.  Click the Home tab.

Using Dialog Boxes
Windows programs make frequent use of dialog boxes. A dialog box is a 
window that requests input from you related to a command you have chosen. 
All Windows programs use a common dialog box structure.

 1. Click the Excel program button on the taskbar to make Excel the active 
window if necessary.

 2.  Click the Microsoft Office Button. The File menu 
displays.

 3. Click Print to display the Print dialog box.

 4.  The Print dialog box contains several types of dialog 
box options.
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 5. To close the Print dialog box, click Cancel, located in the lower right 
corner of the dialog box. The Print dialog box closes without applying 
any changes.

 Another type of dialog box uses tabs to display related options. Only one 
tab can display at a time. The Word Font dialog box offers many options for 
choosing character formatting.

 1. Make Word the active window.

 2. Click the Home tab, and click the small arrow that appears on the right 
of the Font group . The Font dialog box displays.

Figure 10
Print dialog box in 

Excel

Title bar. 
Drag to move box

Drop-down list box. 
Click arrow for more options

Option buttons.
Only one in a group can 

be selected

Text box.
Key text or click

OK command button.
Click to accept specified 
changes in dialog box

Help button.
Click for Help with dialog 

box options

Close button

Cancel command button.
Click to close without 

 applying changes

Check box.
Click to select or deselect

Figure 11
Font dialog box

List box.
Scroll to display; 

click to select

Tabs.
Click to display 

options

Scroll box.
Drag to scroll

Scroll bar.
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in a list box

Vertical scroll arrows.
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 The scroll boxes are used to specify a font by name, its style, and its 
size. When you select a paragraph in a Word document, you can select its 
typographic features using this dialog box. The Font list box at the top left 
displays a list of all the typefaces installed on your computer. By clicking the 
name of the font, you select it for your paragraph.
 The vertical scroll bar on the right side of a list box or a window indicates 
that there is more content to view. To view the hidden content, click the 
downward-pointing arrow or the upward-pointing vertical scroll arrow. You 
can also drag the scroll box on the scroll bar up or down to view all the 
content. The Character Spacing tab at the top of the Font dialog box displays 
additional character formatting options. Click the Character Spacing tab to 
view its contents, and then return to the Font tab.
 Use the Font dialog box to style a paragraph as follows:

 1. Type a very short paragraph in your Word document.

 2. Position the I-beam at the beginning of the text, and hold down the left 
mouse button.

 3. Drag the mouse to the end of the paragraph. The paragraph will change 
color, showing that it has been selected.

 4. Open the Font dialog box by pressing Ctrl � D .

 5. In the Font list box, click Verdana. You may need to scroll down to 
locate it.

 6. In the Font style box, click Bold.

 7. In the Size box, click 12.

 8. If you wish to change the color of your paragraph, move your pointer 
to the Font color drop-down list box and click the down-facing arrow. A 
color pallet appears. Point to the color you wish to use, and click.

 9. When you have completed your selections, click OK at the bottom of the 
Font dialog box and look at the paragraph you have styled. If you wish, 
you can try other font formats, while your paragraph is selected.

Changing the Size of a Window
You can change the size of any window using either the mouse or the sizing 
buttons. Sizing buttons are the small buttons on the right side of the title bar 

that allow you to minimize or maximize the window (see 
Figure 12). This can be especially useful when you would 
like to display several open windows on your desktop and 
see them simultaneously.

 1.   Make Excel the active window, if it is not already. Click 
the Maximize button on the Excel title bar if the Excel 
window does not fill the entire desktop.

Minimize Maximize

CloseFigure 12
Sizing buttons

NOTE

Notice that the window occupies the 
entire desktop, and the Maximize button 
has changed to a Restore Down button. 

This type of function is known as a 
toggle: When a button representing one 
state (Maximize) is clicked, an action is 
performed, the button toggles to the 
alternate state, and the other button 
(Restore Down) appears. A number of 
actions in Windows operate this way.
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 Table 4 describes these buttons. To practice changing the size of a 
window, follow these steps:

TABLE 4 Sizing Buttons

BUTTON USE

Minimize Reduces the window to a button on the taskbar.

Maximize  Enlarges the window to fill the entire desktop (appears 
only when a window is reduced).

Restore Down  Returns the window to its previous size and desktop 
position (appears only when a window is maximized).

 2.  Click the Restore Down button on the Excel title bar. 
The Excel window reduces in size, and the Word 
window appears behind it. The Restore Down button 
has now changed to a Maximize button. Notice that 
the highlighted title bar of the Excel window indicates 
it is the active window.

 3.  Click the Minimize button. The Excel window 
disappears, and its button appears on the taskbar.

How to Display Two Program Windows 
Simultaneously
 1.  Open the Start menu, and click All Programs to open Excel and Word if 

they are not already open from an earlier section of the tutorial.

 2.  Click the Excel button on the taskbar to move its 
window to the front of the screen.

 3.  Click the Restore Down button if the Excel window is 
maximized.

 4.  Move the pointer to the right border of the Excel 
window. The pointer changes to a horizontal 
two-pointed arrow.

 5.  With the two-pointed arrow displayed , drag the 
border to the left to make the window narrower.

NOTE

You can double-click a window title bar to 
maximize or restore the window or 

right-click the program button on the 
taskbar and choose minimize, maximize, 

restore, or close.

TIP

Sometimes the borders of a window can 
move off the computer screen. If you 

are having trouble with one border of a 
window, try another border or drag the 
entire window onto the screen by using 

the title bar.
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 6.  Click the title bar or any part of the Word window 
behind the Excel window. The Word window becomes 
the active window. The Excel window is still open, but 
it is now behind the Word window.

 7.  Click the Maximize button if the Word window does 
not fill the entire desktop.

 8.  Click the Minimize button on the title bar of the 
Word window. The Excel window becomes the active 
window.

 9.  Make the Word window the active window by clicking 
the Word button on the taskbar.

 10. Click the Restore Down button on the Word window. The Word window 
reduces in size. The Excel window might be partially visible behind the 
Word window. You can drag the two reduced windows so that parts of 
both can be seen simultaneously.

11.  Right-click the taskbar, and click Show Windows Side 
by Side. The windows display vertically.

12.  Press the Alt  key, and hold it down while pressing Tab . 
You can switch to the previous window by pressing this 
shortcut, or you can continue to press Tab  to switch to 
an open window on the desktop.

 13. Click the Show Desktop button  located on the Quick Launch toolbar 
to see the desktop. The Word and Excel programs are minimized.

 14. Click the Show Desktop button again to restore the programs.

 15. Click the Close buttons on the title bars of each of the two program 
windows to close them and to show the desktop.

Figure 13
Sizing a window

Two-pointed 
sizing arrow

NOTE

The taskbar contains options to Show 
Windows Stacked, Cascade Windows, and 

Show the Desktop.

NOTE

You can place the pointer on any part of 
the window border to change its size. To 
change both the height and width of the 
window, move the pointer to the bottom 
right corner of the window. The double-

pointed arrow changes its orientation 
to a 45-degree angle (see Figure 13). 
Dragging this arrow resizes a window 

vertically and horizontally.
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Using the Documents Command
Windows lets you open a recently used document by using the Recent Items 
command on the Start menu. This command allows you to open one of up to 
fifteen documents previously saved on your computer.

 1. Click the Start button on the taskbar to display the Start menu.

 2. Click Recent Items. The Recent Items submenu appears, showing you up 
to the last fifteen documents that were saved.

 3. Click a document. The program in which the document was created 
opens, and the document displays. For example, if the document you 
chose is a Word document, Word opens and the document appears in a 
Word program window.

 4. Click the program window’s Close button. The program window closes, 
and the desktop is clear once again.

Changing the Desktop
The Control Panel lets you change the way Windows looks and works. Because 
your computer in school is used by other students, you should be very careful 
when changing settings. Others might expect Windows to look and work the 
standard way. Having Windows look or work in a nonstandard way could 
easily confuse other users. (Table 5 describes how to access other settings.)
 To change the appearance of your computer, follow these steps. Talk to 
your instructor first, however, before changing any settings on your computer.

 1. Click the Start button on the taskbar.

 2. Click Control Panel on the right pane. The Control Panel window displays.

 3. Click the Appearance and Personalization link. The Appearance and 
Personalization window displays.

 4. Click Personalization and click Window Color and Appearance.

 5. Click Default and click OK.

 6. Close the Appearance and Personalization window.

 

TABLE 5 Setting Options

OPTION USE

Control Panel  Displays the Control Panel window, which lets you change 
background color, add or remove programs, change the date and 
time, and change other settings for your hardware and software. 
The items listed below are accessed from the Control Panel.

Network  Includes options to view the network status, connect to a 
and Internet  network, set up file sharing, change Internet options, and so on.

Hardware  Includes options to add a printer, change default settings 
and Sound  for AutoPlay, sound, mouse settings, keyboard, and so on.

Appearance and Includes options to change the desktop background, adjust 
Personalization   screen resolution, customize the Start menu and icons on the 

taskbar, and change sidebar properties.
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Using the Search Command
If you do not know where a file or folder is located, you can use the Search 
command on the Start menu to help you find and open it.

 1. Click the Start button on the taskbar. Notice the blinking insertion point 
in the Start Search box. You can start typing the name of a program, 
folder, or file immediately.

 2. Click Search in the right pane of the Start menu. The Search Results 
dialog box appears.

 3. Click Document in the Show Only section.

Figure 14
Search Results 

dialog box

Key file or 
folder name

 4. Type the name of the file or folder you want to find in the Search box. 
View the search results.

 To search for files by date, size, type, or other attributes, click Advanced 
Search.

 1. Click the arrow to the left of the Search Results text box to specify where 
you want Windows to search. The default location is the C drive.

 2. Click Search to start the search. Any matches for the file are shown in 
the right pane of the dialog box.

 3. Double-click any found item to open the program and view the file or 
folder Windows has located.

 4. When you are finished with your search, close all open windows and 
clear your desktop.
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Using the Run Command
Windows allows you to start a program by using the Run command and 
typing the program name. This command is often employed to run a “setup” 
or “install” program that installs a new program on your computer. It is best 
to use this command after you have become more familiar with Windows 
Vista.

 1. Click the Start button on the taskbar.

 2. Click All Programs, and click the Accessories folder.

 3. Click Run.

Figure 15
Run dialog box

 4. If you know the name of a program you want to run, type the name in 
the Open text box. Often you will need to click Browse to open a  
drop-down list of the disk drives, folders, and files available to you.

 5. Click Cancel to close the Run dialog box.

 6.  Open the Start menu, and locate the Start Search box.

 7. Key run, and notice that the Start menu displays the Run program.

 8.  Click the program name, and the Run dialog box displays.

 9. Close the Run dialog box.

Deleting Files Using the Recycle Bin
The Recycle Bin is the trash can icon on your desktop. To delete a file:

 1. Click its icon, and drag it to the Recycle Bin.

 2.  Double-click the Recycle Bin icon. A window opens 
listing files you have deleted.

 3.  To undelete a file, merely drag it out of the Recycle Bin 
window and place it on the desktop or right-click the 
file and click Restore.

 4. To empty the Recycle Bin and permanently delete files, click Empty 
Recycle Bin in the Recycle Bin dialog box, or right-click the Recycle Bin 
icon. The shortcut menu appears.

 5. Click Empty Recycle Bin.

NOTE

As a protection against deleting a file 
unintentionally, any file you have placed 
in the Recycle Bin can be undeleted and 

used again.
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Exiting Windows
You should always exit any open programs and Windows before turning off 
the computer. This is the best way to be sure your work is saved. Windows 
also performs other “housekeeping” routines that ensure everything is ready 
for you when you next turn on your computer. Failure to shut down properly 
will often force Windows to perform time-consuming system checks the next 
time it is loaded. You can either log off the computer to make it available for 
another user, or shut it down entirely.

To Log Off
 1. Click the Start button on the taskbar.

 2. Click the arrow to the right of the Lock this computer button , 
and click Log Off.

To Shut Down
To exit Windows, use the Lock this computer command on the Start menu. 
This command has several shut-down options.

• Restart: Restarts the computer without shutting off the power. This is 
sometimes necessary when you add new software.

• Shut down: Closes all open programs and makes it safe to turn off the 
computer. Some computers will turn off the power automatically.

• Sleep: Puts the computer in a low-activity state. It appears to be turned 
off but will restart when the mouse is moved. Press the computer power 
button to resume work.

 1. Click the Start button on the taskbar.

 2. Click the arrow beside the Lock this computer button.

 3. Click the Shut Down option.

 4. Windows prompts you to save changes in any open documents. It then 
prepares the computer to be shut down.
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